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I. Introduction to Scientific Presentations

Hello and welcome to your own personal guide to preparing and giving your presentations 

for the DataJam! This manual will tell you all about the important sections that should be

included in your presentation, about making a poster and/or a PowerPoint, and about 

helpful tips for giving your presentations in front of an audience. The purpose of this guide 

is to make your presentations as great as can be, so let’s get started! 

II. Components of a Scientific Presentation

To be able to effectively represent all of the information that you’ve gathered and 

communicate its significance, your presentation should consist of several sections, 

including: 

a. Title
I know what you may be thinking; it’s a no-brainer that everything needs a title! However, 

the title plays a more important role than you may expect it to. It makes a statement; it’s 

the first thing that your audience sees, reads, and hears! The title of your presentation 

should describe as much of your topic as possible without being too lengthy or giving away 

too much. 

Ex. “Traffic Patterns in Pittsburgh” vs. “Changes in Pittsburgh Traffic Patterns from 1975-

2014” (the second option is the better choice!) 

b. Introduction
It’s exactly what it sounds like, folks; your introduction should inform listeners of what 

exactly it is that you’re going to be talking about in your presentation by providing them 

with background info on the subject and your hypothesis. 

i. Background Information

The purpose of including background info is to give the audience some

insight about your topic so that they can better understand your results

and conclusions. The material that you include does not need to go

super in-depth; you want to make sure that everyone can understand

the facts that they are presented with and relate them to the rest of

your project. As a side note, be sure to cite the source of any piece of

info that you use in the References section of your presentation (we’ll

talk about that a little later)!
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ii.  Question/Hypothesis

Your intro should also include the question that your were trying to 
answer while analyzing your data and your hypothesis that you formed 
concerning that question before beginning your research. This lets the 

audience know what the goal of your project was and what you were 

trying to find out with the data that you found/received and will be 

presenting to them.

c. Methods
The methods section is where you discuss the steps that you took throughout the entire 

process of examining your data, determining its significance, and drawing conclusions 

from it that answer the question that you asked. These steps will include, but are certainly 

not limited to: 

i. What dataset are you using/where did you find your data?

Include what specific dataset you are using for your project (like it’s name) and 
what kind of information it contains. Provide a few sample visualizations to 
showcase it’s specific measures and dimensions. It is also a good idea to talk about 
how you obtained the data sets that you used for your project. Did you find them 
on websites? If so, what websites did you find them on?

ii. How did you visualize the data?

Explain/summarize the steps that you took, such as using Tableau Public to create

tables and graphs that helped you to decipher and draw conclusions

from your data (these will be included in your presentation later on!).

Ex. We imported data into Tableau Public, added certain data    

sets/dimensions to the x and y axes, used the bar graph visualization 

option, inspected height of bars/correlation to other data points, etc.  

to determine significance of data. 

- (Note: this is just a short example, so it is more vague than you 
should be!) Be sure to add more detail in your description so 
people know exactly what you did.

iii. How did you interpret the data?

After constructing the visualization(s) of your data, talk about how you 
examined them to draw conclusions about your data. How did you use the 
graphs/charts you made to answer the question that you asked earlier?

Ex. To determine how many car accidents occurred at each time of day, the 

height of each bar in the bar graph was reviewed. 
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iv. Ways to Format Your Methods Section

When it comes to your methods section, sometimes less can be more. Now, you

want to be sure that you explain everything that you’ve done throughout your

project (don’t skip any steps!), but it is not necessary to type out a long paragraph

for each segment. Be descriptive yet brief; bulleted lists and flow charts are best

suited for methods sections!

Ex. This is a short section of a flow chart (the entire chart should be longer). 

d. Results
The results section will include all of the visualizations that you’ve created! Your charts and 

graphs will now show your audience what they showed you before; they’ll represent what 

information that was held in your data set in a manner that is easier on the eyes and on the 

brain (rather than looking at a bunch of numbers).   

 We received a data set from Pittsburgh 
DataWorks. 

We edited the data in Excel (made new 
column headings, rearranged the data within 
the columns, etc.) so that it could be more 
easily read by Tableau Public. 

We imported the edited Excel file with the 
data into Tableau Public and created a bar 
graph with the time of day (day or night) on 
the x-axis and the number of car accidents on 
the y-axis. 
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i. Including Graphs/Tables of Your Data

As stated above, you’ll want to include pictures of all of the graphs and charts you’ve 
created  that have helped you analyze your data. Make sure that they’re large 

enough for everyone to read! Also, you should include a few small sample graphs 

that show the dimensions and measures of the data set you used.

ii. Adding Legends and Captions

It is very important that the visualizations included in the results section are 
accompanied by legends and captions. Both are important in ensuring that the 
audience understands every component of your graph. First off, legends will tell 
those looking what every color or symbol that may appear on a graph means. Many 
computerized graphic programs like Tableau Public automatically generate legends 

whenever you are making a visual! Secondly, captions are very helpful because they 

explain in words what someone is looking at whenever they check out your graph. 

They can be included underneath your visuals.

Ex. of a simple caption: In the graph above, the time of day is plotted on the x-

axis the number of car accidents is plotted on the y-axis. The height of the  

bars in the bar graph represents how many car accidents occurred at each 

time of day in the Pittsburgh area. 

e. Analysis
This may be the best part; the analysis section of your presentation is where you finally 

get to explain what you found by visualizing and analyzing your data! Note: It might be 

easier for you to combine you analysis and conclusion sections! 

i. Explaining What Your Results Mean

Now’s the time to discuss what your data and visualizations are actually telling you. 

By this point, everyone knows what your graphs are showing  them, but what is 

significant about the information? What’s so special about that really tall bar shown 

on your graph?

Ex. After examining the height of each bar on the graph, we found that the 
greatest number of accidents occur at night. We analyzed this statistically by 
collapsing all of the data occurring during daylight hours (8 AM - 6 PM) and the 
data occurring during nightime hours (6 PM - 8 AM) in each city and then using 
a Student's t-test to determine if there was a significant difference between 
daytime and nighttime accidents overall.
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f. Conclusion
Hooray! You’re almost finished. The conclusion is where you wrap everything up and leave 

the audience feeling like they understood the purpose and results of your project. 

i. and ii. Tying Back to Your Intro While Summarizing Your Results and

Data Analysis

In the conclusion, you should try relate your findings to the information provided in 
your introduction. How does it all fit together? The conclusion should also give a 
brief summary (just a few short phrases) of what your results and data analysis told 
you about the significance of your data set once again.

iii. Addressing any Problems

Take this time to also talk about any issues you ran into while visualizing your data 
in  and trying to interpret it (include 1-3 comments). What was confusing to you? 

Did you try using a certain type of graph that ended up being very difficult to read?

g. References
Your reference section should follow your conclusion.It should include a list of any sources 

that you used to build your project and presentation such as where you found your 

background information, where you got your data set from, etc. 

III. Types of Presentations

The two most straight-forward ways to present your information are by using either a 

poster or a PowerPoint presentation. Believe it or not, you will use PowerPoint to create 

either kind of presentation (yes, that includes posters!). We’ll walk you through the steps 

to making a great visual accompaniment to your speech. 

a. Creating a Poster
  A poster is a great way to showcase every part of your project at once. The audience  

       will look at it and immediately be able to see each section (intro, results, etc.). Your 

       poster should be colorful and eye-catching, but be sure to keep it professional (color 

       schemes/fonts should not be too “loud” or obnoxious). Additionally, the sections of     

       your project should be arranged in an organized, logical way.  

Just a Quick Sidenote: There’s no need to make your poster extremely text-heavy; 

bulleted lists and charts should become your best friend. They are much easier to 

look at and read than mountains of typing. The info represented on your poster 

should be thorough, but remember, you will be giving a verbal presentation. 
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Whatever isn’t written down word-for-word is something you can elaborate on 

while your talking with your audience! 

Example Poster Layout: (though it does not need to look exactly like this, just make sure 

that all of the components mentioned are present on your poster) 

● Be sure to also include the name of each member of your team and

the name of your high school on your poster!

Using PowerPoint to Create Your Poster 

You will essentially be building your poster on a single PowerPoint slide and then printing 

that lone slide onto a large poster (trust me, this will make things a lot easier!) 

Steps making a poster in PowerPoint:
1. Open PowerPoint

2. Create a blank slide

3. Click the “Design” tab along the top of the program

4. On the right side of the toolbar, click “Slide Size” and select “Custom

Slide Size…”
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5. Enter in 24 in for the width and 36 in for the height of the slide and click 
OK (or vice versa-you can do what works best for you); these 
measurements will be the dimensions of your physical poster!

6. Click the “Insert” tab along the top and then click “Text Box”

7. Add text boxes to your slide-you will type out the sections of your poster 

(Methods, Conclusion, etc.) in side of them! Move them around as you 

would like.

8. Remaining on the “Insert” tab, click “Pictures” to place your 

visualizations onto the slide.

9. Be sure to save often!

10.More information will be provided later, but when you are finished 

building your poster, you will save your PowerPoint file as a .pdf and send 
it to us.

b. Creating a Slide Presentation
A PowerPoint is another a great way present your research; they are very clean-cut 

and easy to create. They will also follow a similar format to how a poster is built, just 

in slide form! 

Tips: Take a look back at the section of this manual entitled “Components of a 

Scientific Presentation.” There should be a slide (or a few, depending on how much 

info you have for that section) for each one of these components. Again, as you 

would for a poster, be sure not to include too much text on one-slide. Seeing a 

PowerPoint that’s nothing but print can be a little intimidating and make it difficult 

to really engage your audience. As stated before (in the poster section), make use of 

bulleted lists and include pictures and such. Keep in mind that whatever concept is 

not explained in full on a slide is something that can be explained verbally while 

giving your presentation. Finally, try to pick a color scheme that isn’t too out-there, 

and go easy on the transitions (we know that can be fun, but they can be time-

consuming.)  

You want to make sure you do not have too many slides. On average you want to have 
about 1 slide per minute of your presentation, so 10-12 slides for a 10-minute 
presentation. An example of a slides set may be:
• A title slide (with the title, a relevant picture, your team name and the names of all 
students on your team
• A slide with relevant background information
• A slide with your question and hypothesis
• One or two slides with your methods
• Two-three slides with your results
• A slide with the summary of your findings
• A slide with your conclusions
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IV. Giving Your Presentation

For the DataJam final presentation you will be presenting to a panel of judges. Don’t panic! 

This process doesn’t need to be scary. By using the suggestions and instructions included 

in this section, you’ll have all the tools to give a top-notch scientific presentation!     

a. Appropriate Dress
What you wear to give a presentation is important. You want to look polished so that those 

who are listening to your presentation perceive you in a professional manner; if you look 

professional, the audience will think “Wow, they look like they know what they’re talking 

about! I better listen up” (which is what you want, of course). For this specific 

presentation, there’s no need to dress like you’re attending the Oscar’s. A pair of slacks and 

button-up shirt for guys and a nice blouse, pants or a skirt for girls will do the trick.  

b. Presentation Techniques
The following are essential skills that you should practice and utilize to make your 

presentation great! 

i. Volume

Be sure to speak loud enough so that the people you are speaking to can hear

and understand you (not too loud, though; you don’t want to be shouting). Also,

ii. Eye Contact

The #1 message here is to try not to look at your poster or slides for the entire length 

of the presentation and read directly from it. To engage the audience, try to look at 
each person you are speaking to while giving your presentation-it helps to keep 
their attention!

iii. Timing

Your presentation should be 9-10.5 minutes long. Meeting a specific time 
requirement can seem daunting, but as you continue to practice your

presentation (which is super important: practice makes perfect!), it should become 

easier to hit your mark. A good strategy is to assign each group

member the sections that they will be talking about and determining how

long everyone should be talking for. When you practice, you can adjust time frames 

as needed. If you find that your presentation is too long, try to focus

on the most important pieces of information from each section. If your presentation 

is coming up a little short, try to elaborate on the information included in each 

section!
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be sure to face the audience whenever you talk to them-turning away can soften 

or distort your voice. 

iv. Confidence!

If you seem to always get a little nervous when you’re about to give a speech in front of others, 
you’re not alone. Most people, even experienced public speakers, get a little antsy before 
giving presentations. What you have to remember is that this is your time to shine and share 
the information that you have worked so hard to find. Own it! Be proud of it! It’s also important 
to remember that you’ll be presenting with the rest of your group; you’ll be there to back  each 
other up and offer support!

V. Conclusion

Well there you have it, folks! You now have all the tools needed to put together a grade A poster 
and deliver a wonderful presentation that showcases your interesting findings and wows the

judges! We know you all will do a great job. If you have any questions, please do not 

hesitate to email us at PittsburghDataJam@pghdataworks.org.

*Additionally, it is essential that you review the document titled “Requirements for

DataJam Poster” on the DataJam webpage to ensure that your poster and

presentation include everything that the judges will be looking for!






